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Preface

Under UNIX and Windows, EntireX is now installed using the Software AG Installer, which you
download from the Software AG Empower website at http://empower.softwareag.com/. You can
view the documentation for the Software AG Installer under webMethods Product Documentation >
webMethods Product Suite > Documentation by Product > System Requirements, Installation, and Upgrade
on the Software AG Product Documentation website.

The EntireX installation documentation for UNIX and Windows assumes you have successfully
installed the product using the Installer.

This section covers the following topics:

License Concept License Concept for webMethods EntireX.

Software AG Mainframe Product  Software AG's mainframe product licensing procedures, license
Licensing check software and license file.

Port Numbers Ensuring unique port numbers; port number configuration.
Migration Migrating EntireX data from an earlier version (UNIX and Windows).
Installing Fixes Installing fixes from the Software AG Update Manager.
Workbench Plug-ins Installing the EntireX Workbench Plug-ins in Standalone Mode.



http://empower.softwareag.com/
http://documentation.softwareag.com/webmethods/index.htm
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License Concept for webMethods EntireX

License Key Checks

EntireX on all applicable platforms must have a valid license key. If the license key does not match
for a component, the component cannot be used. The license is checked during installation and
when the component is started.

For EntireX Broker, the license file is checked once daily. If the license file is due to expire in the
next 30 days, a warning is issued. This is written to the log file.

Note: The documentation delivered with this product covers all components of EntireX on

all platforms, including those for which you may not have a valid license. The inclusion of
a component or feature in this documentation does not imply that this component/feature
is available for your installed version of the product.

License Key for z/OS received by E-Mail

Normally the EntireX license key is delivered directly on the installation medium as file
EXX951.LICS. This file contains the license information necessary to start EntireX broker. It is no
longer necessary to transfer the file to the host file system.

However, if you received the EntireX license key file EXX951.LICS by e-mail or diskette, you need
to transfer this file to the host file system, using FTP. You will need:

® an FTP client (comes with Windows) and an FTP server on the mainframe, or

= an FTP server on Windows and an FTP client on the mainframe.

» To transfer license file EXX951.LICS to your mainframe host

1  Transfer the file EXXvrs.XML to the host, using FTP.

As the target of the host, use the data set EXX951.LICS provided with the EntireX kit or allocate
a new data set on z/OS with the following attributes:

DSORG=PS
RECFM=FB
BLKSIZE=800
LRECL=80

You must use binary transfer mode to transfer the file EXX951.XML to the host. This ensures
that the license key remains unaltered.
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Note: You cannot "cut and paste” the certificate using a 3270 emulator due to format

incompatibilities: the mainframe is an EBCDIC system, whereas the certificate is an
ASCII-formatted binary file.

2 Ensure that the LICENSE DD card in the broker startup JCL references data set EXX951.LICS.

Example FTP Commands

open <host>

<userid>

<{password>

binary

put EXXvrs.xml '<hlg>.EXXvrs.LICS'
close

bye

License Key on UNIX and Windows

On UNIX and Windows platforms, the XML file is requested during installation and must be
provided by the user performing the installation. The location of license file after installation is
shown below

Operating System | Default Location of License Key File

Windows <webMethods Installation Directory>\ common\ conf

UNIX <webMethods Installation Directory>/common/conf

For future flexibility, the location of the license file is no longer fixed. Although the location after
installation is as mentioned above, the license file can moved to a different location. The new file
entirex.config at a fixed location contains the path to the license file. The location of this file is shown
below:

Operating System

P 9oy Location entirex.config
Windows <webMethods Installation Directory>\ EntireX\ config
UNIX <webMethods Installation Directory>/EntireX/config

File entirex.config contains an entry for the path of the license file, under Windows for example:
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entirex.license.file="<webMethods Installation
Directory>\common\conf\EXX951.xml"

If you want to change the location of the license file, adapt the entry in entirex.config accordingly.
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Software AG Mainframe Product Licensing

This document describes Software AG's mainframe product licensing procedures, license check
software and license file.

Notations Used in this Document:

" vrs,vr orv.r.s:
When used in this document, the notation vrs, vror v.r. s represents the three-digit or two-
digit version number of the Software AG product.

" ppp:
When used in this document, the notation ppp represents the three-character product code of
the Software AG product: ADA for Adabas, NAT for Natural, EXX for EntireX, COM for Com-
plete, WCP for Entire Net-Work and NPR for Entire System Server.

Distributed License Check Software

This section describes the data sets (files) containing this software. All licensing data sets have
names starting with the characters MLC. The vrs in the names represents the version of the license
check software, which is not necessarily the same as the version of your Software AG mainframe
product.

For instructions on copying the data sets from the product installation medium to disk and loading
the libraries contained on the data set, refer to the appropriate installation procedure for your
mainframe product.

= 7/OS Licensing Data Sets

= 7/V'SE Licensing Data Sets

= BS2000/0SD Licensing Data Sets
z/OS Licensing Data Sets

The following licensing data sets are provided in z/OS environments:

Data Set Name Description

MLCvrs.LOAD |Mainframe license check load modules

MLCvrs.JOBS |Mainframe license check sample jobs
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z/VSE Licensing Data Sets

The following licensing data sets are provided in z/VSE environments:

Data Set Name |Description

MLCvrs.LIBR |Mainframe license check load modules

MLCvrs.LIB] |Mainframe license check sample jobs

BS2000/0SD Licensing Data Sets

The following licensing data sets (files) are provided in BS2000/OSD environments:

Data Set Name  [Description

MLCvrs.MOD |Mainframe license check load modules

MLCvrs.JOBS |Mainframe license check sample jobs

License File

You must install a valid license file on all mainframe platforms in which your Software AG
mainframe product is installed.

The license file is provided as an XML document (encoding is US-ASCII). This document can be
viewed using a browsing tool or text editor on a PC. It can also be viewed on the mainframe using
the DISPLAY function of the license utility, LICUTIL, described later in this document. The license
file contains text, which represents the licensing information and a digital signature, the license
key. Among other things, it displays Software AG legal notices and environmental information.

@  Caution: The license file must remain in ASCII format -- even on the mainframe. It must not
be modified. Any modification of the license file will invalidate the digital signature and
the license check will fail. If the check fails, please contact your Software AG technical
support representative.

Delivery and Installation

Your individual product license is shipped on the product installation medium as pppvrs.LICS
data set (file) or as an e-mail attachment in the file format pppvr.xml.

Once the license file is received, either copy it from the product installation medium to disk or use
native FTP commands to transfer it to your mainframe host before using it during the mainframe
product installation.
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During the mainframe product installation process, the license file is then loaded and processed
as required by your Software AG mainframe product. Refer to the appropriate installation procedure
for your Software AG mainframe product for further information.

Copying a License File to Disk

For instructions on copying a pppvrs.LICS data set (file) from the product installation medium to
disk, refer to the appropriate installation procedure for your Software AG mainframe product.

Transferring a License File from PC to a z/OS Host Using FTP

If a license file is supplied as an e-mail attachment, you must transfer the attached license file from
the PC to the mainframe using native FTP commands provided in this section.

@ Caution: Using utilities instead of native FTP commands for the license file transfer may

corrupt the license key.

A\  Important: Make sure to switch to binary transfer and verify that the resulting data set has
RECFM=FB or RECFM=F and LRECL=80.

» To transfer a license file from the PC to a z/0S host, perform the following steps:

1  Save the product license file e-mail attachment as pppvr.xml on your PC's hard disk.

2 Startan FTP session for communication with the z/OS host using the following FTP command:

ftp host-name
where host-name is the name of the z/OS host.

Enter your z/OS host login ID and password.

3  Switch to binary data mode (the license file must retain its format as ASCII during the transfer):
binary

4  Specify that the data set for the license file must be written with RECFM=FB and LRECL=80:
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quote site RECFM=FB LRECL=80 BLKSIZE=4000
RECFM=F is also supported for product license files.
5  Write the license file as a data set on the z/OS system:
put pppvr.xml "hilev.pppvrs.LICS'
where hilev is the high-level qualifier (for example, SAG) to be used for the data set.

This command will create a data set called hilev.pppvrs.LICS with RECFM=FB, LRECL=80, and
the license information stored in the data set will be in ASCII format.

Transferring a License File from PC to a z/VSE Host Using FTP

If a license file is supplied as an e-mail attachment, you must transfer the attached license file from
the PC to the mainframe using native FTP commands described in this section.

The FTP sample session described in these steps loads the license file onto a member of a z/VSE
library. It is possible to load the license file onto a sequential z/VSE data set instead. For more in-
formation, refer to your FTP documentation.

@ Caution: Using utilities instead of native FTP commands for the license file transfer may

corrupt the license key.
/), Important: Make sure to switch to binary transfer and verify that the resulting data set has

RECFM=FB or RECFM=F and LRECL=80.

» To transfer a license file from the PC to a z/VSE host, perform the following steps:

1  Save the product license file e-mail attachment as pppvr.xml on your PC's hard disk.

2 Startan FTP session for communication with the z/VSE host using the following FTP command:
ftp host-name
where host -name is the name of the z/VSE host.

Enter your z/VSE host login ID and password.

3 Once the FTP session has been established, you can optionally delete the default working
prefix. To determine what the default working prefix is, enter the following command:

General Installation Information 9



Software AG Mainframe Product Licensing

pwd

To delete the default working prefix, enter the following command:
cd ..
Point to the z/VSE sublibrary for the license file, for example, USERLIB.MYSUBLIB:

cd USERLIB.MYSUBLIB

Switch to binary data mode (the license file must retain its ASCII format during the transfer):

binary

Specify that the data set for the license file must be written with RECFM=FB and LRECL=80:

quote site recfm fb 80

RECFM=F is also supported for product license files.

Write the license as a member in the libraries on the z/VSE system you identified in Step 4:

put pppvr.xml pppvrs.LICS

This command will write the license file pppvr.xm1 to a member called pppvrs.LICS. If you
requested a library and sublibrary of USERLIB and MYSUBLIB in Step 4, the pppvrs.LICS file
would reside in the USERLIB.MYSUBLIB library. The data set will have RECFM=FB, LRECL=80,
and the license information stored in the member will be in ASCII format.

Transferring a License File from PC to a BS2000/0SD Host Using FTP

If a license file is supplied as an e-mail attachment, you must transfer the attached license file from
the PC to the mainframe using native FTP commands described in this section.

o

A

Caution: Using utilities instead of native FTP commands for the license file transfer may

corrupt the license key.

Important: Make sure to switch to binary transfer and verify that the resulting data set has
file type SAM and RECFORM=V.

» To transfer a license file from the PC to a BS2000/0SD host, perform the following steps:

1

Save the product license file e-mail attachment as pppvr.xml on your PC's hard disk.

10

General Installation Information



Software AG Mainframe Product Licensing

2 Start an FTP session for communication with the BS2000/OSD host using the following FTP
command:

ftp host-name
where host-name is the name of the BS2000/OSD host.

Enter your BS2000/OSD host user ID, password and account number (if relevant).

3  Switch to binary data mode (the license file must retain its ASCII format during the transfer):
binary

4  Specify that the file for the license file must be written with FCBTYPE=SAM and RECFORM=V:
quote file pppvrs.LICS,FCBTYPE=SAM,RECFORM=V

5  Write the license file to the BS2000/OSD host:

put pppvr.xml pppvrs.LICS

Product License Check FAQs

= Why has Software AG introduced a license check for products on the mainframe?

= Which information is contained in a product license?

= What exactly is meant by the CPU ID?

= Which Software AG mainframe products require a product license?

= How is the product license file installed?

= How can | read the product license file?

= How can | display machine-specific data?

= When is the product license checked?

= Which items of a product license are checked?

= Does the Software AG mainframe license check software support a disaster recovery scenario?
= What happens if the product license is incorrect, insufficient or not installed?

= How can | get a new product license file if the delivered license file is insufficient for my environment?
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= Do | need separate product licenses for different machines?
Why has Software AG introduced a license check for products on the mainframe?

Software AG wants to ensure that customers run our software products only on mainframe ma-
chines for which they have valid and sufficient product licenses. This ensures that we have better
control of the use of our software products. On other platforms (UNIX, Windows), the product
license check has been established for many years.

Which information is contained in a product license?

A product license is a sequential file with US-ASCII text in XML format containing the following
items:

= Software AG header

® customer information (Name, ID)

" encrypted license key

" license expiration date (or unlimited)

® product information (product code, version, name)

" environment information (operating system type, CPU ID, LPAR ID, system name, capacity)
What exactly is meant by the CPU ID?

IBM defines the CPU ID as the “central processing complex node descriptor sequence number”.
It is the unique hexadecimal machine serial number without the machine model number.

The CPU ID and other machine data can be viewed by using the DISPLAY function of the license
utility, LICUTIL, described later in this document.

Which Software AG mainframe products require a product license?

® Adabas

® Natural

" EntireX

® Com-plete
Entire Net-Work

Entire System Server
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How is the product license file installed?

Transfer the license file from the product installation medium or PC to disk as described in the
installation documentation for your Software AG mainframe product or the various Transferring
a License File from PC to a xxx Host section sections respectively. Then proceed as described in the
appropriate installation steps for your mainframe product.

How can | read the product license file?

® The product license file can be read on a PC by means of an XML editor (file type .xml) or any
PC text editor.

® The license utility, LICUTIL, provided with the Software AG mainframe license check software
includes a function that allows you to display the license (DISPLAY function). For more inform-
ation about the license utility, read Using the License Utility: LICUTIL.

How can | display machine-specific data?

The license utility, LICUTIL, provided with the Software AG mainframe license check software
includes a function that allows you to display machine-specific data (DISPLAY function). For
more information about the license utility, read Using the License Utility: LICUTIL.

When is the product license checked?

The product license is checked every time the product is initialized. In addition, the product license
is checked once a day.

Thirty days before the license expires, license check failure messages will warn you that it is time
to obtain a new license.

If a license check fails, contact your Software AG technical support representative.
Which items of a product license are checked?

Product license items are divided into three logical license groups (License Key, Product-Specific
Information and Machine-Specific Information) and checked in that order. If an inconsistency in
any one of these groups is detected by the license checker, the succeeding items of that logical license
group are also checked. Then the check terminates with corresponding error messages. For example,
if the license key expires, the license key check terminates with an error before the license checker
checks any product-specific or machine-specific information.

The following table identifies the product license items comprising each logical group:
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Checking [Logical License Product License Item Included

Order Group Name

1 License Key The encrypted license key

2 Product-Specific Information |® The expiration date (if any)
= The operating system (z/OS, z/VSE or BS2000/OSD)
® The product code (for example, ADA, NAT or EXX)
® The product version, in either v. r. or v. r. s format.

3 Machine-Specific Information |® The machine CPU ID

® The machine capacity (only in z/OS and z/VSE environments)

The logical partition (LPAR) ID (if applicable)

Does the Software AG mainframe license check software support a disaster recovery scenario?

Yes. Please contact your Software AG sales representative to obtain a license file which is able to
support disaster recovery scenarios. The parameter DisasterRecoveryCPUIDs in this license file
allows you to specify one or more CPU IDs of the machines to be used when your production
machine fails. If you do not have these CPU IDs available, it is possible to specify the value Unknown.
In this case, the license checker issues a warning message when a disaster recovery scenario is
assumed.

In a disaster recover scenario, no machine data besides the CPU ID is checked.

What happens if the product license is incorrect, insufficient or not installed?

Thirty days before the license expires, license check failure messages will warn you that it is time
to obtain a new license.

How can | get a new product license file if the delivered license file is insufficient for my environment?

Contact your Software AG sales representative to get a correct product license file according to
your contract. It can be shipped by e-mail either in ASCII format or in the converted assembler
input format.

14
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Do | need separate product licenses for different machines?

No, it is possible to have multiple CPU IDs defined in one license file.

Using the License Utility: LICUTIL

The license utility, LICUTIL, is a batch utility that is used to check the license file, convert the license
file into an assembler source module and display the license file and machine data.

LICUTIL is provided with Software AG's mainframe license check software contained on the data
sets MLCvrs.LOAD (z/OS), MLCvrs.MOD (BS2000/OSD) and MLCvrs.LIBR (z/VSE).

Error messages for the license utility are documented with the rest of your Software AG product
messages.

This section provides detailed information of each function provided by the LICUTIL utility. The
functions can be executed by using the sample JCL described later in this section. The syntax of
the functions that can be supplied with the LICUTIL command is shown in the following diagram:

CHECK

DISPLAY {ALL | LICENSE | MACHINE}

END | EXIT

HELP

LOADLIC module-name

MAKE
DATE={yyyy-mm-dd | yyyymmdd}

SET FORMAT={FREE |LEFT |ISTRUCTURED}
PRODVER=pppv.r.s
RMODE={ANY |24}

The parameters and variable values that can be supplied with each function, are described in the
following section. For explanations of the syntax symbols used in the diagram, please read the
documentation for your specific Software AG mainframe product.

= CHECK Function: Check the Product License

= DISPLAY Function: Display License ltems and Machine Data

= END/EXIT Functions: Terminate the License Utility

= HELP Function: View LICUTIL Help

= MAKE Function: Convert the License File to Assembler Source
= | OADLIC Function

= SET Function: Set LICUTIL Options

= JCL Examples and Requirements
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= | |ICUTIL Licensing Messages
CHECK Function: Check the Product License

The CHECK function can be used to check the license file against the product's execution environ-
ment. The original license file must be provided as input along with the product code and version.
If the license file is not valid, appropriate error messages are returned.

& Important:

There are no parameters, however, to run the CHECK function successfully, you must have pre-
viously specified the SET PRODVER function to provide the product code and version number.

The following items are checked, in the following order:

1. License key.

2. Product-specific data, including the product code, version, operating system and expiration
date.

3. Machine-specific data, including the CPU IDs, the capacity (on only z/OS and z/VSE systems)
and the logical partition (LPAR) ID.
DISPLAY Function: Display License ltems and Machine Data

Use the DISPLAY function to display the contents of the product license items (license file, product-
specific information and machine-specific information) and to display machine data (CPU ID,
machine type, model ID, LPAR ID, MSU) about the machine on which the utility is being run.

The parameters of this function are described in the following table. At least one parameter is re-
quired.

Parameter  |Description

ALL Display the product license items and machine data. ALL is the default.

LICENSE |Display only the product license items.
MACHINE |Display only the machine data.
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END/EXIT Functions: Terminate the License Utility

Use the END or EXIT function to terminate the license utility. These functions should be used if
LICUTIL is running interactively in environments other than batch (for example, TSO under z/OS).

HELP Function: View LICUTIL Help
Use the HELP function to review a list of the available LICUTIL functions and their syntax.
MAKE Function: Convert the License File to Assembler Source

Use the MAKE function to convert the license file into an assembler source. After assembling this
source (and linking it), the resulting license module can be used by defined Software AG products
(for example, Adabas or Natural) instead of the license files. For more information about using

license modules, refer to the installation documentation provided with your Software AG product.

Sample Output

Here is some sample output from this function when run on a z/OS system:

MLC9006 License converted to assembler output. 042 records written
to SYSUT2.

LOADLIC Function

This function is provided with the MLC 1.2 SP4 (or higher) licensing software and applies to z/OS
only.

Use the LOADLIC function to load the license module after you converted (MAKE function), as-
sembled and linked the assember source. module-name denotes the name of the license module in
the load library.

LOADLIC can be specified only once per LICUTIL session.

After the license module has been successfully loaded by LOADLIC, you can further process the
module using other LICUTIL functions such as CHECK and DISPLAY.
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SET Function: Set LICUTIL Options

This function is provided with the MLC 1.2 SP4 (or higher) licensing software.

Use the SET function to set options for the license utility.

The parameters of this function are described in the following table. At least one parameter is re-

quired.

Parameter |Description

DATE Sets the date for the license check. The default is today. The format of the date can be either
yyyy-mm-ddor yyyymondd, where yyyy is the four-character year, mmis the two-digit month,
mon is the three-character month abbreviation and dd is the two-digit day.

FORMAT |Sets the display format for the DISPLAY function. There are three different formats:
= Specify FREE (the default) to produce output without XML tags.
= Specify LEFT to produce output with each XML tag in a new line.
= Specify STRUCTURED to produce output with each XML tag indented.

PRODVER |Sets the product code and version for the CHECK function. The format in which the product
code and version should be specified is pppv.r.s.

RMODE  |Sets the RMODE for the assembler source produced by the MAKE function:
B Specify 24 (the default) for 24-bit addressing mode.
= Specify ANY for either 24- or 31-bit addressing mode.

JCL Examples and Requirements

Sample JCL of the license utility functions can be found in the following members of the licensing
data sets (files): MLCvrs.JOBS for z/OS and BS2000/OSD, and MLCvrs.LIB]J for z/VSE.

Member Functions Included Demonstrates how to...
LICCHECK (SET Check a license file with LICUTIL.
PRODVER=pppv.r.s
DISPLAY
CHECK
LICMAKE |MAKE Convert the license file to assembler source.
LICMDATA |DISPLAY MACHINE |Display machine data. This function can be used to send Software AG

the required data for a license file.

This section covers the following topics:
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= 7/OS JCL Requirements

= 7z/VVSE JCL Requirements

= BS2000/0SD JCL Requirements
z/0S JCL Requirements

The following file assignments are used by the license utility in z/OS environments:

DD Name |Description

SYSIN Input of LICUTIL control parameters.
SYSPRINT |Output of LICUTIL run.
SYSUT1 |Input of original license file (pppvrs.LICS data set).

SYSUT2  |Output of license converted to assembler source.

The following table shows which file assignments are required in the JCL by each LICUTIL function
(an X in a table cell indicates that the file assignment is required; a blank cell indicates that file
assignment is not required):

License Utility Function |DD Name
SYSIN|SYSPRINT|SYSUT1|SYSUT2

CHECK X X X

DISPLAY ALL X X X

DISPLAY LICENSE |X X X

DISPLAY MACHINE |X X

MAKE X X X X

HELP X X

z/VSE JCL Requirements

The following file assignments are used by the license utility in z/VSE environments:

File Assignment|Description

SYSIPT Input of LICUTIL control parameters and the input of original license file (pppvrs.LICS
data set).

Note: The license file has to be stored in a sublibrary.

SYSLIST Output of LICUTIL run.

SYSPCH Output of license converted to assembler source.

The following table shows which file assignments are required in the JCL by each LICUTIL function
(an X in a table cell indicates that the file assignment is required; a blank cell indicates that file
assignment is not required):
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License Utility Function

File Assignment

SYSIPT|SYSLIST|SYSPCH
CHECK X X
DISPLAY ALL X X
DISPLAY LICENSE |X X
DISPLAY MACHINE | X X
MAKE X X X
HELP X X

BS2000/0SD JCL Requirements

The following file assignments are used by the license utility in BS2000/OSD environments:

System File | Description

SYSDTA |Input of LICUTIL control parameters.

SYSOUT |Output of LICUTIL run.

Link Name

SYSUT1 |Input of original license file (pppvrs.LICS data set).

SYSUT2 |Output of license converted to assembler source.

The following table shows which file assignments are required in the JCL by each LICUTIL function
(an X in a table cell indicates that the file assignment is required; a blank cell indicates that file
assignment is not required):

License Utility Function

File Assignment

SYSDTA |SYSOUT |SYSUT1 |SYSUT2
CHECK X X X
DISPLAY ALL X X X
DISPLAY LICENSE |X X X
DISPLAY MACHINE | X X
MAKE X X X X
HELP X X
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LICUTIL Licensing Messages

The messages in this document may be produced when using the LICUTIL utility.

MLC1001

Explanation

Action

MLC1002

Explanation

Action

MLC1003

Explanation

Action

MLC1004

Explanation

Action

MLC1005

Explanation

Action

CPU-ID {cpuid} is not defined in your product license

The CPU ID listed in the message (cpuid) is not defined in your product license.
Either your license file is invalid or you have attempted to run the Software AG
mainframe product on a machine for which it is not licensed.

Install and run the Software AG product on the machine for which it is licensed. If
the problem persists, contact your Software AG sales representative for assistance.

LPAR name {lparname} is not defined in your product license

The LPAR name listed in the message (/parname) is not defined in your product
license. Either your license file is invalid or you have attempted to run the Software
AG mainframe product on a machine for which it is not licensed.

Install and run the Software AG product on the machine for which it is licensed. If
the problem persists, contact your Software AG sales representative for assistance.

Machine capacity {value} higher than MSUs in your product license

The machine or the partition capacity (value) of the CEC or LPAR respectively on
which you have attempted to install and run the Software AG mainframe product
exceeds the capacity allowed in your product license. Either your license file is invalid
or you have attempted to run the Software AG mainframe product on a machine for
which it is not licensed.

Contact your Software AG sales representative for assistance.

The product license will expire on {timestamp}

This warning message provides the date and time (¢ 7mes t amp) when the license will
expire for this Software AG mainframe product.

No action is required for this warning message. However, you should contact your
Software AG sales representative to obtain an updated license soon.

We assume CPU-ID {cpuid} as your DR or DR testing environment

The CPU ID listed in the message (cpuid) is not defined in your product license.
Therefore we assume that you are running in a disaster recovery environment.

If you are running in a disaster recovery environment, no action is required for this
warning message. If you are not running in a disaster recovery environment, contact
your Software AG sales representative to obtain an updated license.
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MLC2001 The product license is invalid

Explanation Your product license is invalid.

Action Contact your Software AG sales representative for assistance.

MLC2002 The product license key is invalid

Explanation The license file for the Software AG mainframe product is invalid.

Action Verify that the license file was transferred correctly to the mainframe host and that it
is still in ASCII format. If the problem persists, contact your Software AG sales
representative for assistance.

MLC2003 The product license is not for {value}

Explanation The license file for the Software AG mainframe product is not for the operating system
(OS), product code, or product version listed in the message (value).

Action Use the correct license file. If the problem persists, contact your Software AG sales
representative for assistance.

MLC2004 The product license has expired on {timestamp}

Explanation The product license has expired. The date and time it expired is given in the message
(timestamp).

Action Contact your Software AG sales representative for assistance.

MLC2005 Tag missing in product license: {tagname}

Explanation The tag with the name listed in the message (tagname) is missing in your product
license.

Action Contact your Software AG sales representative for assistance.

MLC2006 Invalid tag value in product license: {tagname}

Explanation The value of the tag with the name listed in the message (tagname) is invalid in your
product license.

Action Contact your Software AG sales representative for assistance.

MLC2007 Current CPU-ID not found for product license check

Explanation The CPU ID of the CPU on which the product license check was run is not found in
the license file.

Action Contact your Software AG sales representative for assistance.
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MLC2008
Explanation

Action

MLC2009

Explanation

Action

MLC2010

Explanation

Action

MLC9001
Explanation

Action

MLC9002
Explanation

Action

MLC9003
Explanation

Action

MLC9004
Explanation

Action

The number of MSU values in the product license is incorrect
The machine capacity covered by the product license is incorrect.

Contact your Software AG sales representative for assistance.

ExtendedRights setting {value} not allowed under this system

The ExtendedRights setting listed in the message (va /ue) is not supported by your
system.

Contact your Software AG sales representative for assistance.

Soft capping is not allowed with ExtendedRights {value}

Your product license does not allow soft capping with the ExtendedRights setting
listed in the message (value).

Contact your Software AG sales representative for assistance.

License exceeds maximum size of 8000
Your license file is too large.

Contact your Software AG sales representative for assistance.

Error opening license file input
An error occurred during an attempt to open the license file input.

Investigate the cause of the error, paying special attention to the corresponding error
messages produced by the operating system. Contact your Software AG sales or
support representative for assistance.

Error reading license file input
An error occurred during an attempt to read the license file input.

Investigate the cause of the error, paying special attention to the corresponding error
messages produced by the operating system. Contact your Software AG sales or
support representative for assistance.

Error opening license file assembler output
An error occurred during an attempt to open the license file assembler output.

Investigate the cause of the error, paying special attention to the corresponding error
messages produced by the operating system. Contact your Software AG sales or
support representative for assistance.
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MLC9005
Explanation

Action

MLC9006

Explanation

Action

MLC9007

Explanation

Action

MLC9009
Explanation

Action

MLC9010

Explanation

Action

Error writing license file assembler output
An error occurred during an attempt to write the license file assembler output.

Investigate the cause of the error, paying special attention to the corresponding error
messages produced by the operating system. Contact your Software AG sales or
support representative for assistance.

License converted to assembler output records written to output file

The license file was successfully converted to an assembler source module. Output
records were written to the output file.

No action is required for this informational message.

Error loading license module {modulename} {errorcode}

The LOADLIC function (z/OS only) tried to load a license module from the load
library and received an error (errorcode) from the operating system.

Correct the LICUTIL input, removing duplicate LICUTIL function calls. Check that
the license module (modulename) is in the load library, that the correct library is
referenced in the JCL, and that the module name is specified correctly in the LOADLIC
statement (case sensitive, a blank between LOADLIC and modulename).

DMS Error
A DMS error occurred (only in BS2000/OSD environments).

Investigate the cause of the B52000/OSD DMS error. If you need assistance, contact
your Software AG support representative.

LOADLIC can only be issued once, before any DISPLAY, CHECK, MAKE or READ

The LOADLIC function (z/OS only) can only be performed once per LICUTIL session.
LOADLIC must not be preceded by the DISPLAY, CHECK or READ function. These
functions can only locate the license module after the LOADLIC.

Correct the LICUTIL input, removing duplicate LICUTIL function calls. Change the
call order so that the LOADLIC precedes any DISPLAY, CHECK or READ.
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Ensuring Unique Port Numbers

The following four port numbers must be unique for each installation of EntireX.

® Default EntireX Broker
= TCP/IP port
" SSL port
® Administration
= TCP/IP port
® SSL port
Uniqueness checks are performed during installation. If one port in a block (Default EntireX

Broker or Administration) is in use, both ports in this block are recalculated. You can change
these values as required.

Any new port number must be a positive integer greater than 1024. If you enter a port number
that is already in use, an error message is displayed. All four ports must be assigned correctly
before the installation can continue.

Port Number Configuration

In versions before 8.2, the default broker ID was "Tocalhost", which implied "Tocalhost:1971"
(default port number). From version 8.2, however, the default port number can be changed during
installation, and must be changed in the case of a multiple installation (see Ensuring Unique Port
Numbers).

The following configuration/property files for RPC servers in directory EntireX/config contain a
default broker ID:

" dotNetServer.cfg (Windows only)

" cserver.cfg

" microfocusserver.cfg

" exxatm.cfg

® entirex.cicseci.properties

" entirex.imsconnect.properties

" entirex.javarpcserver.properties

" entirex.rpcacibridge.properties
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" entirex.wmgbridge.properties

" entirex. wmgbridgelistener.properties

" entirex.xmlrpcserver.properties

The configuration/property files are updated automatically during installation.

"BrokerID=localhost"isnow "BrokerID=1ocalhost:1971", or if port 1988, for example, was
specified during installation, "BrokerID=localhost" becomes "BrokerID=1ocalhost:1988".

If the port numbers are changed after installation, you need to update the config/property files in
the list above accordingly.
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Migrating EntireX Data from Earlier Versions

This chapter describes how to migrate an earlier version of EntireX to version 9.5 under UNIX or
Windows. EntireX version 9.5 can only be installed in parallel to an existing EntireX version. In
this scenario you can migrate user data from one installation to the other easily, using the steps
described here. The information applies to both UNIX and Windows systems; any differences are
described explicitly.

Note: In this chapter, source refers to an earlier EntireX installation, and target refers to the

current EntireX version 9.5.

Migrating EntireX Broker Data

The broker attribute files are located at <inst_dir>/EntireX/config/etb. Follow the steps below to
migrate broker data from one installation to the other:

» To migrate broker data

1  Stop all running EntireX brokers in both the source and target installations. EntireX brokers
from other installations and platforms are not affected.

2 Stop all running RPC Servers that are registered to EntireX brokers in source or target install-
ations. This also includes remote RPC servers or RPC servers from other EntireX installations
if these RPC servers are registered with the brokers to be shut down.

3  Stop the Broker Administration Service/Daemon.

® Under UNIX:
Stop the UNIX broker admin service, using the script

EntireX/bin/sagnetbsrv

where 1 is a number in both installations, e.g. "sag2etbsrv stop".

® Under Windows:
From the Control Panel in both installations, choose Administration > Services >Stop
Software AG EntireX Broker Admin Service

Note: The first installation does not have a number to identify it. The second and

subsequent installations are appended with (2), (3) etc.

4  Copy all relevant directories of defined brokers from source to target installation. These dir-
ectories - one for each broker - are located under <inst_dir>/EntireX/config/etb.

Note: Copy the complete directories, not just the attribute files.
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5  Check the broker attribute files for path names and adapt them to the target installation.

6  Restart the Broker Administration Service/Daemon.

® Under UNIX:
Start the broker admin service for both installations, for example with command

sagl2etbsrv start

" Under Windows:
From the Control Panel, restart the Software AG EntireX Broker Service for both installations.

Following the above steps, autostart settings and user credentials are not migrated. Apply these
manually in the new installation. When you restart the Broker Administration service, all brokers
will be shown. Readjust the autostart settings and user credentials, using System Management
Hub.

You do not need to move Broker definitions (attribute file etc.) that are stored outside the EntireX
installation directory. Simply makes sure when you start a broker stored externally that the broker
executable from version 9.5 is used. This may apply to your scripts or when you start a broker
manually.

Migrating Authorization Rules

Authorization rules cannot be migrated and must be reentered in the new installation. You can
readjust them using System Management Hub.

Migrating RPC Servers

You can migrate manually all RPC servers of the source installation that are visible in System
Management Hub and maintained using System Management Hub.

» To migrate RPC servers

1 Copy the file <inst_dir>/EntireX/config/rpc.server.properties from source to target installation.

2 Inthisfile, adapt path names that reference your source installation to your target installation.

Paths of RPC servers other than the source installation can remain unchanged.
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Migrating Web Services

Please note the following when migrating Web services to a more recent version of EntireX:

= Artifacts such as XMM or AAR files can be reused without regeneration.
® Make sure Web Services Stack and EntireX are on the same level.

® Modify your scripts (for example the start script of the XML/SOAP RPC Server) so that they use
the new versions of the relevant JAR files of Web Services Stack and EntireX.

Migrating XML/SOAP Components

This section applies to migrations from EntireX version 8 and above. For EntireX version 7, see
Migrating XML/SOAP Components from EntireX Version 7.n in the XML/SOAP Wrapper document-
ation.

This section covers the following topics:

= Migrating XML/SOAP RPC Server
= Migrating XML/SOAP Wrapper
= Migrating XML/SOAP Listener

Migrating XML/SOAP RPC Server

Update the start script to set the paths to current installation. If the properties file contains a path
to the configuration file, you may need to adjust the path. The properties and configuration files
can be used as before. See Configuration File for the XML/SOAP RPC Server in the UNIX and Windows
administration documentation for more information.

Migrating XML/SOAP Wrapper

Update the start script to set the paths to current installation.
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Migrating XML/SOAP Listener

Using the Software AG Web Server / Software AG Runtime from Software AG Installation

Save your Web services (AAR files) and modified configuration files (i.e. axis2.xml). You do not
need to re-generate your Web services (AAR files). If the configuration was modified, perform the
same modifications for the new installation and restart the Software AG Web Server. Redeploy
the web services (AAR files).

| Note: The new installation will use another port by default, which means that the Web clients
need to be adjusted.

Using another Web Server

Save your Web services (AAR files) and modified configuration files (i.e. axis2.xml). You do not
need to re-generate your Web services (AAR files). For deployment of file wsstack.war and copying
file entirex.jar to Web Services Stack, see the separate Web Services Stack documentation, also
available under webMethods Product Documentation on the Software AG Documentation website.

If configuration was modified, perform the same modifications for new installation and restart
the Web server. Redeploy the Web services (AAR files).
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Eclipse Workbench Considerations

EntireX Workbench is part of the Eclipse-based Software AG Designer.

We recommend you import existing projects into a new workspace of your target installation. We
do not recommend reusing an existing Eclipse workspace. This may damage data or result in
strange behavior.

This section describes how to import the projects of Software AG Designer from an earlier version
into the workspace of the new Software AG Designer 9.5, then redeploy the Web services to the
new Web Services Stack 9.5. It covers the following topics:

= QOverview
= Migrating your Preferences (Optional)
= Migrating Projects to Software AG Designer 9.5.1
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= Redeploying Web Services

Overview
Old Eclipse Old WSS
Workspace Environment

project_01 ' e ------------ - webService_01 '— - 9880999000000 .
Deployed
pmje::t_ﬂ,?' e ------------ - webService_02 ' - ---------- :

Import
Y
New Eclipse New WSS
Workspace Environment
(2]
pmje::t_mb P webService 01 '
Redeploy
pmje::t_ﬂ,.?b P webService 02 '

D Notes:

1. We recommend importing your old Eclipse workspace when you install Software AG Designer
version 9.5. See also Migrate Designer Projects under Upgrading webMethods Products on the
Software AG Product Documentation website.

2. We recommend you redeploy your Web services to the new Web Services Stack environment.
3. Existing applications can continue to use web Services in an old Web Services Stack environment.

4. However, if you wish to access the redeployed web Services in the new 9.5 Web Services Stack
environment, your existing applications must be modfied accordingly.

General Installation Information 35


http://documentation.softwareag.com/webmethods/index.htm

Migrating EntireX Data from Earlier Versions

Migrating your Preferences (Optional)

Before you migrate your old projects, you can optionally migrate your existing preferences to your
new 9.5 installation.

» To migrate the preferences to the new workspace (optional)

1 Open Software AG Designer 9.5 and point to a new 9.5 workspace. Accept the default
"workspace95" or specify another one.

2 Export your preferences before upgrading;:

1. Start the old version of Software AG Designer with the old workspace.
2. Choose File > Export.... In the Select panel, chose General > Preferences and click Next.

3. In the To preference file field, specify the EPF (Eclipse Process Framework) file to which
you want to export your preferences, then click Finish.

3 Import these preferences to the new workspace:

1. Start Software AG Designer 9.5 with the new workspace.
2. Choose File > Import.... In the Select panel, choose General > Preferences and click Next.

3. In the From preference file field, specify the EPF file to which you exported your prefer-
ences, then click Finish.

Migrating Projects to Software AG Designer 9.5.1

» To import projects into Software AG Designer 9.5

1  Choose File > Import.... In the Select panel, choose General > Existing Projects into Workspace
and click Next.

2 Inthe Import Projects panel, choose Select Root Directory and go to the old workspace. The
projects appear in the Projects box. Select the projects to import into Software AG Designer
9.5.

3  Choose Copy projects into workspace and click Finish.

36 General Installation Information



Migrating EntireX Data from Earlier Versions

Redeploying Web Services

» To redeploy the Web services

1  Select an AAR file and from the context menu choose Web Services Stack > Deploy Services
Package.

2 Select the correct URL that points to the Web Services Stack 9.5 installation.
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Installation Steps

To install a fix you need the Software AG Update Manager (SUM). The Software AG Update
Manager is available from the Software AG Installer.

O software software AG Installer About

P rosy Fel ] Directory  Products Languages ic g Configure Canfirm Install

Create a custom installation below, or select typical development installations: Typical Installations ...

Iflanguane packs are available for selected products, vou will be ahle to select language packs later.
E)=j=y=

®-I Adapters

= Appling

®-I~ Broker

#- CentraSite

®-I~ Database Configuration

®-7 Designer

®-[" Documentation

- Entirex

®-I Infrastructure

®-I Integration Server

F-T My webhethods Server

AT by webMethods User Interfaces
I Platform Manager 9.5 SP1 Installed Yersion:
I-Univergalhneaaaging Product Size:

Selected Yersion:

T RENENEDEY — Free Space Required: 538 MB
Free Space Available: 17720 B
= Back et = Cancel

» To install a fix using the Software AG Update Manager

1 Start the Software AG Update Manager and choose Install fixes from Software AG Empower.
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2

| =X

6 software~ Software AG Update Manager

Copyright © 2013 Software AG, Darmstadt, Germany
and/or 5oftware AG USA, Inc., Reston, VA, United States of America,
and/or their licensors.

Install fixes from Software AG Empower [ ] Also create script
Install fixes from image

Create or add fixes to fix image

Yiew installed fixes

Uninstall fixes

Installation directory: | DASoftwareAGIENtireX9511 | Browse

Empower user name: | Password: |

Imageﬁlename:| || Browse |

Scriptﬁlename:| || Browse |

| Apbout || Next> || cancel |

Specify the installation directory and supply your Empower credentials.

Select the fix you want to install and continue with Next.
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5 software~ Software AG Update Manager

Installation Directory: D\Software AGVEX<9511

## Software AG Update Manager E_ﬁ

Select Fixes.
& ] Designer | ExpandAll | | CollapseAll |
EntireX 9.5 SP1 Fix1
: || shared Plug-ins
B[] 55X | selectAll | | Clearmn |

[ Readme... ] [ Fix Content ]

|
| <Back || Newt> || cancel |

The fix is now installed.

r #7 Software AG Update Manager l — | Li:ijﬂ

§ software* Software AG Update Manager

The following fixes were installed.You might need to perform post-installation tasks for fixes you installed.

For instructions, see the fix readmes in D:\SoftwareAG\EX{95111\UpdateManager'readme.

. Designer
“- @ EntireX 9.5 SP1 Fix1

For details, see Update Manager logs in
D:\SoftwareAG\EXC{9511\ UpdateManagertlogsiinfolinfo.log

The following fixes could not be installed.Update Manager will return the products to the last stable state.

The following fixes were partially installed.Call Software AG Global Support.

[ Home ] [ Close I
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Verifying the Fix Version

After restarting the Designer server you can verify the version of the EntireX components.

_'.,_,. About Software AG Designer Features M =]

About Software A Designer Features |

Provider I Feature Mame | \ersion I Feature Id
Software AG Entirel Workbench 9,5.1.0000-0... com.sofbwareag.entirex.ide. —h
I Pat|
7= Feature Plug-ins M=l B3
Feature Plug-ins |
Plug-ins contributed by Feature: com.softwareag. entirex.ide. eclipse, exx
Itvpe filker kewxk
Sig. .. | Provider | Plug-in Mame = | Yersion | Plug-in Id I
E Software AG #pache Commons ¥ML 5c...  1.4.7 org.apache, ws,commons, s
CH| Software AG EntireX .MET “Wrapper 9.5,1,0000-0282 com.sofbwareag. entiresx.ids
Software AG Entirex Adapter for Integr...  9.5.1.0000-0252 com.softwareag. entirex.ids
Software A Entirex Administration 9.5,1.0000-0282 com.softwareag. entirex, ac
Software AG Entirex Base 9.5.1.0000-0252 com. sofbwareag. entiresx. ru E
E Software AG Entirel i Wrapper 9.5,1.0000-0282 com.sofbwareag. entirex. ids
E Software AG Entireix Core Components 9.5,1.0000-0252 com.softwareag. entirex. cc
EE| Software AG Entirelx Custom Wrapper 9.5,1.0000-0282 com.softwareag. entirex.ids )
i
1 | & Software AG Entirey DICOM Wrapper 2.5,1.0000-0252 com. softwareag, entires:, idr ke
prmr=— & Software AG Entire¥ Extractor and \Wra...  9.5.1.0000-0282 com. softwareag, entiresx, ids
Er Software AG Entire Extractor and Wra...  9.5,1.0000-0282 com.sofbwareag. entire:x.ids
D Software AG Entirex Extractor and Wra... 9.5.1.0000-0282 com.softwareag. entirex. idi
B Software AG Entirer Java \Wrapper 2.5.1.0000-0252 com. softwareag, entires:, idr
x E Software AG Entire RPC Server 9.5.1.0000-0252 com. sofbwareag. entirex.rp
R: & Software A Entire¥ Server Configuration  9.5,1.0000-0282 com.sofbwareag. entirex.ids
B Software AG Entired LI 9,5,1.0000-0282 com.softwareag. entirex.ids g
Th EE Software AG Entirex Web Service WWrap...  9.5.1.0000-0282 com.softwareag. entire:x.idi
2: & Software AG Entirer Workbench 2.5,1.0000-0252 com. softwareag, entires:, idr
Af Software AG EntireX Workbench Help 9.5.1.0000-0282 com.sofbwareag. entirex. be B
Software AG EntireX ¥ML Mapping Editor  9.5,1.0000-0282 com.sofbwareag. entiresx.ids
Software AG Mrwizardackivator# 9.5,1.0000-0282 com.softwareag. entirex. idi
(ﬁj EE| Software AG Software AG IDL Editor Fo...  9.5.1,0000-0252 com. softwatreag, entires:, idr
J | H
=
k?) Legal Infa Show Sigring Info Colurnns. .. |
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Uninstalling the Fix Version

You can use the Software AG Update Manager to uninstall the fix:

ii,;_.—-'- Software AG Update Manager

§ software~ Software AG Update Manager About

Action: IFix Management LI

Install fixes from Software AG Empower
Install fixes from imane
Create or add fixes to fix imaoge

Uninstall fixes
Yiew installed fives
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Installing the EntireX Workbench Plug-ins in Standalone Mode

| Note: This section is applicable if you want to install the Workbench plug-ins in standalone
mode, that is, not as part of the full webMethods EntireX installation.

Prerequisites

Prerequisites for all EntireX components are described centrally. See Prerequisites in the EntireX
Release Notes.

Scope

The webMethods installation contains a folder <suite installation folder>\eclipse\updates
with archived update sites of all the features installed. To install the EntireX Workbench into some
Eclipse use the archived update sites:

® eclipse.exx.UpdatePackage.zip

= com.softwareag.common.zip

® eclipse.wss.nnn.UpdatePackage. nnnn.zip

The Eclipse features com.softwareag.common.zip and com.softwareag.wsstack.ui_n.n.n.nnn are pre-

requisites for installing the Workbench plug-ins in standalone mode. All features listed above can
be installed in one installation step.

See EntireX Workbench for more information.

Eclipse 4.3 Considerations

Eclipse 4.3 Connecting to Update Site

The Eclipse Update Manager automatically checks whether updates are available for the newly
installed Eclipse 4.3 during the first plug-in installation performed from the user interface.

The user will not be notified of the system access to the remote system. However, at this point no
user-relevant data has been sent.

The user may be requested for user ID and password before connecting to the remote update site.

After submitting the credentials, a list of updates for the newly installed software is retrieved from
the remote system.
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| Note: Nothing is installed without the consent of the user.

Updating the features of Eclipse may establish a connection to the Software AG Update Site, which
is hosted on Empower, the Software AG customer extranet. To use this update site, an Empower
customer account is needed. For internal distribution, consider setting up a mirror update site.
This avoids access to the Software AG customer extranet.

Installation Steps

= |nstallation in Eclipse Headless Mode
= |nstallation in GUI Mode

Installation in Eclipse Headless Mode
For installation in Eclipse headless mode, use the following commands to install the three features:

eclipse --Tauncher.suppresskErrors -nosplash -application <
org.eclipse.update.core.standaloneUpdate -data $WORKSPACE
-command install -featureld com.softwareag.common -version v.r.s.hhhh-bbbb
-from /opt/softwareag/eclipse/updates/com.softwareag.common.zip

eclipse --launcher.suppresskErrors -nosplash -application <«
org.eclipse.update.core.standaloneUpdate -data $WORKSPACE

-command install -featureld com.softwareag.wsstack.ui -version v.r.s.hhhh-bbbb <
-from /opt/softwareag/eclipse/updates/eclipse.wss.vrs.UpdatePackage.nnnn.zip

eclipse --Tauncher.suppresskErrors -nosplash -application <
org.eclipse.update.core.standaloneUpdate -data $WORKSPACE

-command install -featureld com.softwareag.entirex.ide.eclipse.exx <
-version v.r.s.hhhh-bbbb -from <
/opt/softwareag/eclipse/updates/eclipse.exx.UpdatePackage.zip

where vrs is version, release and service pack level
hhhh is the hotfix number, and
bbbb is the build number

This is recommended for all UNIX platforms that are not Linux.
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Installation in GUI Mode

Follow the instruction in the Eclipse Help. It can be found inside Eclipse at Help > Help Contents
> Workbench User Guide > Tasks > Updating and installing software or on the Web at http://help.ec-
lipse.org/kepler/topic/org.eclipse.platform.doc.user/tasks/tasks-129.htm.

Install the three features listed above. You can use drag-and-drop to add the three archived update
sites from the folder <suite installation folder>\eclipse \ updates to the list of update sites to visit.

Configuring the License

Before you can use the views and the editor of the plug-in, EntireX Workbench needs a license.
The default license file name is exx95.xml. The EntireX Workbench checks the folder <webMethods
Installation Directory>\common \ conf for the license file. If the license file is not found, you have to
configure it manually. Follow the steps below:

» To configure the license

s Choose Window > Preferences > Software AG > EntireX > Installation and set the location
of the license file.

E Preferences l (=

type filter teut Installation =T v

a EntireX -
MET Wrapper

The license file is required for using the EntireX. Changing the location of the licenses file
requires restart of Eclipse to take effect.

C Wrapper
COBOL Wrapper License File: t:\SnftwareAG\common\conﬂenﬂﬁ.xml Browse...

Custem Wrappe
DCOM Wrapper
Deployment Env
EIB Wrapper

IDL Extractor for
| IDL Extractor for
IDL Extractor for
Installation

m

Integration Serve
lava Wrapper
Matural Wrapper
PL/T Wrapper

RPC Environmer I
Web Service Wra

. — WAl hdnnninnrl:r i ’Restore gefaults] ’ Apply ]

@ [ ok ][ canca |
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Or:

Set the license file location when you use one of the views, the IDL Editor, an extractor, or a
wrapper. A dialog asks for this location on the first use.

The location of the license file must be set for each Eclipse installation you use.

Uninstalling the EntireX Workbench Plug-ins

Uninstalling the EntireX Workbench plug-ins is done by using the Uninstall wizard. Usage is de-
scribed at Help > Help Contents > Workbench User Guide > Tasks > Updating and installing
software or on the Web at http://help.eclipse.org/kepler/topic/org.eclipse.platform.doc.user/tasks/tasks-
129.htm.
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